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TICRA Tools 20.0 release note 
In this release we have improved the TICRA Tools framework and our 
products GRASP, QUPES, ESTEAM and CHAMP 3D. The first sections 
describe the new features, some of which are general for all products 
included while others are product specific. This is followed by a list of all bug 
fixes as well as enhancements made to the products. 
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New features common to all products 
Distance measurements in 3D-Views  

A new feature is available for measuring distances between two points in the 3D-View. This 
possibility makes it significantly easier to verify the definition of a complex model in TICRA Tools. 
The measurement tool is invoked by clicking the yellow ruler icon in the 3D-view, which will allow 
the selection of two points. The distance will then be computed in the default length unit specified 
in the preferences, with optional projection onto a coordinate plane. In addition, the geometrical 
coordinates below the mouse pointer are now always shown in the application status bar, 
whenever the pointer is positioned over an object in an active 3D-View. Note that the points are 
always displayed in the user-defined coordinate system specified in the 3D-View settings.  

  

Convenient selection of tutorial cases 

A new and convenient selection of the tutorial cases provided with TICRA Tools is now available 
from the screen shown at start-up. Currently, 36 different cases are included to illustrate various 
use cases of TICRA Tools. 
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Optimisation goal based on user-defined expression 

A new type of optimisation goal is now available, providing the capability of optimising a user-
defined expression with a dependency on the selected optimisation variables. For instance, the 
user may choose to minimise the value of the expression “length_a + length_b”, where “length_a” 
and “length_b” may either be optimisation variables or other real variables with some 
dependency of one or more optimisation variables. This provides a convenient way of maximising, 
minimising or targeting a user-defined property of the antenna system being optimised.    

User-defined colours 

It is now possible to customise the colours used for most of the geometrical objects available on 
the Antennas & Scatterers tab. The colours are specified in the 3D-View settings of the object in 
question. As for other 3D view properties, the colours may be specified for all objects of a specific 
type, or they may be customised for each object independently. Further, the default surface and 
line colours applied for new objects may be specified in the 3D view section when you go to Tools 
-> Application Options. For some objects, e.g. MoM Meshes, colour-coding is used by TICRA Tools 
to indicate various properties of the scatterer, in which case the colours cannot be customised by 
the user.  

     

Frequency group 

A new class is now available for simplifying the setup of multi-band antennas. Objects of the new 
class Frequency Group contain a list of references to other frequency or wavelength objects. The 
typical use of this feature is to define two separate frequency band objects defining the frequency 
sampling within a receive and a transmit band, respectively. The “Rx” and “Tx” frequencies may 
then be collected in a frequency group object, implying that the specification of the analysis or 
the optimisation problem only needs to be defined for a single frequency group. This is particularly 
useful when a large number of CHAMP 3D devices are connected in a Combined Device – it is then 
recommended to define all devices so that they refer to the same frequency group object, 
implying that the user can easily switch between multiple bands or frequency definitions by only 
modifying a single object.    
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New derivative-free optimisation algorithm 

A new optimisation algorithm, the so-called “Derivative-free” algorithm, is now available in TICRA 
Tools. The new algorithm is a local optimisation algorithm but unlike the gradient-based 
algorithms, the derivative-free algorithm does not require partial derivatives to be evaluated in 
each iteration. This is highly beneficial in applications where the cost function is time-consuming 
to evaluate and where partial derivatives need to be evaluated through a numerical finite-
difference approach. A typical application scenario is the optimisation of a waveguide device in 
CHAMP 3D. 

Project comment and list of job comments 

It is now possible to specify a project comment in the project properties available in the File menu. 
Further, a convenient overview of the comments provided for each job has been introduced on 
the results tab. By clicking the toolbar icon “View all job comments”, the user will be presented 
with a list of comments for all jobs. The list may be printed and it is possible to search for specific 
text strings. This makes it easier to find the right job when a project includes many jobs.  

Project cleanup 

A new feature has been included for making it significantly easier to clean a project for unused 
objects. An object is considered unused if it is not referenced by any commands or from any other 
object. The feature can be activated through the Edit->Delete->Project Cleanup menu. When an 
unused object is deleted, it may create a new unused object that is no longer referenced by other 
objects. The project cleanup can therefore be applied recursively, so that all objects not 
referenced via any commands are automatically deleted. For performing a partial cleanup it is 
also possible to right click on a class branch in the tree view and select Delete Unreferenced 
Objects. This makes it possible to clean all unused objects of a specific type, e.g. all unused 
electrical objects. When objects are deleted, it is possible to undo the operation afterwards if the 
result was not as expected.  

Trigonometric functions with arguments in degrees available  

Expressions entered in input fields can now take advantage of the following trigonometric 
functions with arguments in degrees: sind(), cosd(), tand(), asind(), acosd(), atand() and atan2d(). 
The standard trigonometric functions with arguments in radians remain unchanged.   

Easier duplication of optimisation managers 

It is now possible to right-click on an Optimisation Manager tab, which will make it possible to 
duplicate the optimisation manager.  As previously, the functionality is also available in the menu 
Tools->Manage Optimisations, which is active when the Optimisation tab is selected. 

Unattended installation now supports more options 

The unattended installation mode when installing from the command line now supports more 
options. Use “--help” as argument to the installer to see the available options.  
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GRASP – New features 
Reflector wizards can now create design expressions and variables 

The single- and dual-reflector wizards are useful for setting up a model of a reflector system, 
based on a few design parameters. A new checkbox “Create design variables” has been introduced 
in the two wizards. When this option is chosen, the GRASP wizard will create all the necessary 
objects and commands as previously, but now it will also create the input design variables as 
objects. Furthermore, the design expressions used by the wizard will be inserted as expressions 
in the relevant attributes in the objects. This implies that the reflector geometry can easily be 
changed later, simply by changing the value of the design variables. Further, it is significantly 
easier to perform a high-level reflector system optimisation by including the design variables as 
optimisation variables on the Optimisation tab. 

New tutorial cases 

Multiple new tutorial cases have been added to GRASP, including a tutorial showing how a simple 
parametric sweep can be obtained.  

New Electrical Properties object defined by Periodic Unit Cells (Requires QUPES) 

A new Electrical Properties class, Periodic Surface Electrical Properties, has been introduced. It 
gives the user the possibility to create electrical properties defined by any periodic geometry.  
Previously, the user had to use the Tabulated Electrical Properties class where an external file was 
needed. With the new Periodic Surface Electrical Properties object you can define a Periodic Unit 
Cell (PUC) using QUPES and use it directly on your reflector/plate object, keeping the entire 
analysis/design within the TICRA Tools framework. This is useful for many antenna applications 
using periodic surfaces, e.g. FSS subreflector designs, mesh reflectors, beam waveguides, quasi-
optical networks, etc. 

BoR MoM meshes can now be visualised  

The computational mesh used when doing BoR MoM computations can now be visualised by 
checking the “MoM meshes” checkbox in the 3D view settings. 

 

QUPES – New features 
Parameter binding for Periodic Unit Cells (PUC) and Quasi-Periodic Surfaces (QPS) 

It is now possible to bind element parameters on different layers to each other. This makes it 
easier to design multilayer reflectarray and FSS designs since the geometry in multiple layers can 
now be controlled by a single parameter. This gives the user more flexibility in the design, offering 
the possibility of reducing the number of optimisation variables when optimising PUC and QPS. 
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Improved analysis accuracy for Quasi-Periodic Surfaces (QPS) with rear illumination 

In the previous release of QUPES an approximation was applied when illuminating a QPS from the 
rear side. This approximation has been removed, hence improving the analysis accuracy for QPS 
with rear illumination. 

Plotting of analysis mesh in the 3D view of Periodic Unit Cells (PUC) 

Following many customer requests it is now possible to view the analysis mesh of PUCs in the 3D-
View of PUCs. 

Plotting of new reflection/transmission coefficients 

When plotting reflection/transmission coefficients of the scattering parameters of Periodic Unit 
Cells, it was only possible to plot the linear polarisation components, i.e. TE and TM components. 
This implied that the user had to use external tools to plot circular components. It is now possible 
to also plot circular polarisation components as well as the axial ratios.  

Graphical view of the layers in Periodic Unit Cells (PUC) object editor 

It is now possible to have a 2D graphical view of the different layers specified in the Layer Info 
attribute of planar PUC objects. This makes it easier for the user to examine if the different layers 
are correctly specified. This view is accessed in the PUC object editor. 

Speed-up of Periodic MoM analysis using database 

Some speed-up on the computation time of Periodic MoM analysis using database has been done. 
This is significant in particular for cases where the source is a Plane Wave Expansion. 

 

ESTEAM – New features 
Reduced memory and time for MLFMM setup 

For very large cases, particularly when running simulations on a machine with a high number of 
threads, MLFMM will require less memory and computation time during setup. 

 

CHAMP 3D – New features 
Coupling and GTD calculations possible with Radiating Devices 

Radiating Devices, used to calculate radiation from feeds, can now be employed in coupling 
calculations. In other words, the coupling equation, as defined in Section 4.8 in the User’s Manual, 
applies to a Radiating Device and an approximate value of the coupling to other sources can thus 
be obtained. The Radiating Device class has, accordingly, been equipped with the Ray Output 



 

8 

TICRA Tools 20.0 release note            
June 2020 

attribute. In addition, Radiating Devices are now also allowed in GTD calculations when CHAMP 
3D is combined with GRASP. Hence, the source attribute of an object of the classes Single Reflector 
GTD and Multi GTD can refer to an object of class Radiating Device.  

More flexibility in CAD export 

The commands Export to STEP and Export to IGES have, when applied to Devices, two new 
attributes, Coordinate System and Device Location, that are used to determine the location of the 
device in the CAD representation. 

Improved CAD export of Combined Devices 

CAD export of Combined Devices was previously based on a mesh of the entire Combined Device, 
resulting in a suboptimal CAD representation. Now, each Device in the Combined Device object is 
exported separately using, if available, a dedicated CAD representation not based on a mesh.  

2D CAD export possible 

The new command Export to 2D STEP File provides CAD export of Rotationally Symmetric Devices, 
Body of Revolution Scatterers and Horn Sections. With default settings the command exports the 
generatrix of the rotationally symmetric structure in the zx-plane.     

CHAMP 3D wizard remembers previous settings 

When invoking the CHAMP 3D wizard, the settings from a possible previous run within the same 
project is remembered. This is also the case if the project is closed and reopened later. In line with 
the GRASP wizard, the CHAMP 3D wizard now offers the possibility to choose the prefix of the 
generated objects. It is thus possible to either overwrite previously generated objects or to create 
new ones. To allow reverting to default settings, each page of the wizard is equipped with a 
Restore Default button.  

Bor Mesh exteriors can be edited in the 2D-View  

The 2D-View offers editing of an exterior of class BoR Mesh. It is possible to insert, delete and 
move nodes as well as inserting segments between nodes by using the mouse. The node number 
is shown as a tooltip when hovering the cursor over the node. All details of the new editing 
features are described in section 3.2.3.3 in the User’s Manual.  

Circular Symmetric Apertures work for exteriors with coordinate systems   

The Body of Revolution Scatterers, defining the exterior in the Multi-Port Circular Symmetric 
Aperture or the Circular Symmetric Aperture, were previously only allowed to be defined in the 
global coordinate system.  Now, the coordinate system of any of the Body of Revolution Scatterers 
can be different from the global one, provided that the origin is located on the z-axis of the global 
system and the z-axis is parallel to that of the global one.     
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The 2D-View supports Standard Circular Waveguide Ports 

The 2D-View previously supported the devices Circular Symmetric Aperture or Circular Symmetric 
Horn with Circular Waveguide Ports. Now, the view also works with Standard Circular Waveguide 
Ports.  

New device: Circular Waveguide Dielectric Slab  

This new 3D device is used to set up a dielectric slab in a circular waveguide. A typical application 
for this device is to design polarisers.  

Increased flexibility in Rectangular Waveguide Step and Stepped Rectangular Waveguide 

A limitation for these devices was previously that it was not possible to let, for instance, the x-
dimension of the step increase while decreasing the y-dimension. This limitation is no longer 
present. 

Increased flexibility in Circular Waveguide Cross Iris 

It is now possible to define separate lengths and thicknesses for the two orthogonal iris arms.   

Increased flexibility in Waveguide Smooth Twist 

The input and output ports of the above-mentioned device are no longer required to have 
identical dimensions. 

BoR-MoM integration rules adjusted (also applies to BoR-MoM in GRASP) 

The integration rules for filling the BoR-MoM matrix have been adjusted, resulting in faster 
evaluation time in some cases with an insignificant change of results. BoR-MoM is used in GRASP 
with the BoR-MoM object as well as in CHAMP 3D when analysing Circular Symmetric Apertures 
and circular symmetric waveguide devices for which BoR-MoM is chosen as analysis method.   

Better mode matching convergence for Circular Symmetric Horn with horn sections containing 
dielectrics 

The number of internally calculated modes used in mode matching analysis of the Circular 
Symmetric Horn device now depends on the dielectric constant in the horn sections. Also, the 
discretisation of the Smooth Walled Section takes into account the dielectric constant. This gives 
rise to faster convergence with respect to the attributes Steps per Wavelength and Additional 
Modes in Percent of the Mode Matching Settings object.  

Automatic switch to MLFMM when out of memory (requires ESTEAM) 

In case a Waveguide Device is analysed with MoM and the simulation requires more memory than 
available, an out of memory error was previously issued, although an MLFMM simulation would 
be possible. Now, CHAMP 3D automatically switches to MLFMM in this case. However, the use of 
MLFMM requires that a license for ESTEAM is available. 
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Copy/paste of Modal Spectrum Plot supported in Results tab 

In the Results tab it is now possible to copy/paste a Modal Spectrum Plot. This plot is generated 
by the Get Modal Spectrum in Waveguide Port command. 

 

Bug fixes common to all products 
Intermittent error when integrating large surface current distribution 

An intermittent and rarely encountered error which would cause TICRA Tools to abort with an 
“Access Violation” or a “Segmentation Fault” message has been corrected. On some platforms, 
the job could continue past the error and produce a file with no valid numbers.  The error would 
only occur for near field computations and only for rare cases involving extremely large current 
distributions.  

Renaming a variable object could fail 

Renaming a variable could fail in uncommon cases where the variable is referenced from a 
command attribute. The error would be reported as an “invalid real number”.   

Duplication of optimisation managers lead to surprising results 

On the Optimisation tab, the menu Tools->Manage Optimisation allows the user to manage the 
existing optimisation manager objects. However, if an optimisation manager was duplicated, the 
variables included for optimisation would stay synchronised between the old and the new 
manager, even when a subsequent modification by the user was supposed to only affect a single 
optimisation manager. The old and the new optimisation manager are now independent if the 
Duplicate button is used.   

Object editor could become unsynchronised and show stale data 

If an object being edited in the TICRA Tools GUI was shown on a reference tab – i.e. not the first 
tab in the object editor window – then an invocation of an undo or a redo could cause the object 
editor to become unsynchronised so that stale data were shown. 

Updated input files not discovered during job execution 

During job execution, TICRA Tools will generally read the input files at the beginning of the job, 
whereas subsequent file modifications occurring during the job execution will not be recognised. 
This is the intended behaviour, except for cases where the input file is actually being updated by 
TICRA Tools as a part of the job execution. TICRA Tools will now discover if a data file written as 
part of the job execution is used as input file later in the same job. In such cases the input file will 
be re-read. This allows for instance a tabulated feed object to be used for enforcing power 
normalisation inside an optimisation loop.  
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Quitting TICRA Tools while 3D-View Settings window is open could crash GUI 

The TICRA Tools GUI could shut down in an uncontrolled fashion if the “3D-View settings” window 
was open while the user attempted to quit the TICRA Tools application.    

Batch mode analysis could be blocked at startup when ghost objects were present 

If a ghost object, i.e. an object not yet created, was referenced inside a user-defined function in 
the tci-file then TICRA Tools could sometimes prevent the batch run from starting properly, even 
though the missing object was correctly created before the first use through a create or copy 
command.  

Intermittent GUI crash during optimisation 

The TICRA Tools GUI could crash in some cases, when an optimisation was running, and the user 
was interacting with the “Optimisation Progress” window. 

GUI crash with circular object references in scatterer clusters 

The GUI could crash if the user had scatterer clusters with circular references (e.g. two scatterer 
clusters referencing each other). An error is now reported for this illegal project setup.  

Error when copying list of frequencies with variables 

If a list of frequencies contained one or more cells with variables and expressions, a copy/paste 
operation of those cells could fail in the TICRA Tools GUI. 

Non-optimal orientation of the 3D-View 

The use of the “xy”-projection in the 3D-View would lead to a view where the global x-axis was 
oriented in the vertical direction and the global y-axis was oriented in the horizontal direction. 
The orientation is now more in line with expectations for the “xy” and other projections.    

Results from Get Pattern on a Surface Cut could not be plotted 

A data file created by using the Get Pattern command with a Surface Cut object as target could 
not be plotted in the TICRA Tools GUI. The computed field values in the data file were correct but 
the plot in the GUI could fail. 

Pattern template could disappear from plot after closing and opening project 

If a pattern template is displayed on a plot and the project is closed and later re-opened, the 
template was no longer shown. 

Major/minor steps misbehaves in 2D plot 

When selecting “Use fixed scale” in the Axis Properties window of a 2D plot the major/minor steps 
may not behave as expected.  
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The Set Attribute command could not be edited in the GUI after creation 

The Set Attribute command allows the user to modify object settings during job execution. 
However, it was not possible to use the GUI to modify the command after the initial creation. This 
issue was present in all previous versions of TICRA Tools but not in older GRASP versions. 

Unexpected behaviour of log scale button in optimisation progress window 

The log scale option in the optimisation progress window did not behave properly when variables 
or residuals were negative.   

 

Bug fixes in GRASP 
Crash in PO computations on scatterer clusters with electrical properties 

A crash could occur if a PO, Multi-face Scatterer object referenced a scatterer cluster, where 
some of the scatterers are referencing Electrical Properties objects and others do not. 

Crash when renaming objects in projects involving arrays  

A crash could occur in TICRA Tools 19.1.1 when an object referenced directly or indirectly from an 
array object was renamed. No other versions of TICRA Tools were affected by this issue.   

Missing GTD diffraction from holes when numerical diffraction method is used 

The GTD diffraction in reflector holes defined by rim objects was missing when the diffraction 
method was set to Numerical in the associated GTD Scatterer object. 

Some feeds may not be drawn in 3D-Views when arrays are present 

If a project involved an array some feeds could erroneously be missing in the 3D-View drawing.  

Attribute z_offset for circular symmetric reflectors not taken into account in PTD-calculations 

For the two circular symmetric reflector classes, the Spline Reflector as well as the Tabulated 
Reflector, the attribute z_offset was not taken into account in PTD calculations. Hence, the PTD-
contribution was wrong if z_offset differs from 0. 

Automatic determination of number of modes in BoR-MoM calculation disabled after first use 

If a BoR-MoM object, with Min m-Mode and Max m-Mode set to -1 to enable automatic 
calculation of number of necessary azimuthal modes, is used more than once in a job, this 
automatic calculation was disabled after the first use. 
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Bug fixes in QUPES 
Invalid output from QUPES in rare case 

In the rare case that the Poynting’s vector of a source is exactly zero on the surface of a periodic- 
or quasi-periodic surface, the output could become undefined (not a number).  

Incorrect error messages when editing the geometry of selected Periodic Unit Cells (PUC) 

For a few selected predefined PUC, where Element Parameters are specified using different units, 
e.g. “m” for one parameter and “mm” for another parameter, an incorrect error message was 
issued.  

Not all rims worked together with Quasi-Periodic Surfaces 

It is now possible to apply triangular, super-elliptical and polygonal rims with Quasi-Periodic 
Surfaces objects. 

Updated default settings when plotting Quasi-Periodic Surfaces (QPS) in the 3D-view 

When plotting QPSs in the 3D-view the default setting was to hide the QPS objects. This has been 
corrected such that the default setting is to show the QPS objects. 

Incorrect rotation angles when using Export Periodic Unit Cell Electrical Properties command 

The command Export Periodic Unit Cell Electrical Properties did not properly scale values with 
angular units, i.e. rotation variables. Consequently, the resulting analysis mesh was rotated 
incorrectly.   

Better checks for inconsistent definition of dielectric regions  

A new algorithm for error checking has been introduced, checking for the feasibility of the setup 
of dielectric regions when analysing Periodic Unit Cells using Periodic MoM, 3D Elements. It can 
detect if an incorrect region, i.e. an unphysical setup of homogeneous regions has been defined. 
Previously this scenario would in some cases go undetected and the results would be in error. 

Periodic MoM Settings, 3D Elements could not handle empty regions in mesh files 

Tabulated mesh files may contain an empty region, i.e. a region where no patches are defined. 
The treatment of such empty regions was incorrect for Periodic MoM Settings, 3D Elements and 
has been corrected. 
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Bug fixes in ESTEAM 
Meshing improvements 

Several improvements have been made to the meshing algorithms, in particular for some cases 
involving highly curved geometry. 

Integration precision for Local Properties in Composite MoM/MLFMM Scatterer adjusted 

Setting Local Properties to Enhanced Accuracy or High Accuracy for all scatterers in a Composite 
MoM/MLFMM Scatterer object and setting Expansion Accuracy to Normal in the referencing 
MoM/MLFMM-object, would not use the same integration precision on waveguide ports as the 
case in which Local Properties were not used, and the MoM/MLFMM Expansion Accuracy was set 
to Enhanced or High, respectively. Hence, marginally different results were obtained which was 
not the intended outcome. Now, both scenarios give the same results. 

Better checks for inconsistent definition of dielectric regions  

A new algorithm for error checking has been introduced, checking for the feasibility of the setup 
of dielectric regions in a MoM/MLFMM problem. It can detect if a rogue region, i.e. a region which 
is not in contact with region 0, directly or via other regions, has been defined. Previously this 
scenario would go undetected and the results would be in error. If the GUI is used, the offending 
patches will be marked in the 3D-View. 

 

Bug fixes in CHAMP 3D 
Near fields from Circular Symmetric Apertures excited with TEM mode could be in error 

In case a Circular Symmetric Aperture is excited with a coaxial TEM mode and the maximum 
azimuthal modes indicated in the associated Waveguide Port Modal Expansion Settings object is 
larger than zero, the calculated near field was in error. 

Get Radiating Device Circular Symmetric Beam Parameters command could produce wrong 
results 

If the radiating device on which this command is invoked involves highly directive reflectors, the 
outputs Max cx-polar to peak, Direction of Maximum cx-polar Level, Half Beam Widths and Best-
Fit Phase Centers were in error.  
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Wrong results when Rectangular Waveguide Rectangular Iris and Circular Waveguide 
Rectangular Iris are analysed with mode matching 

When analysed with Mode Matching, the phase of the transmission parameters for the above-
mentioned devices had wrong sign. Also, they were analysed using the opposite value of the iris 
rotation angles in case this was non-zero.  

Standard Circular Waveguide Ports are too large 

The radii of all standard circular waveguide ports were a factor of two too large.  

Wrong Normalisation of 3D Surface Currents for Circular Symmetric Apertures 

The 3D surface currents on the exterior of a Circular Symmetric Aperture with Power 
Normalisation set to "Directivity", obtained by running the Get Radiating Device Current Colour 
Plot command, were not correctly normalised. For a typical fundamental TE11 mode excitation, 
the currents were 3 dB too low. For other excitations the deviation was different. 

Command Write MoM Mesh for a Circular Symmetric Device uses fixed value of Relative 
Geometrical Tolerance  

For Circular Symmetric Devices the command Write MoM Mesh did not use the value of the 
Relative Geometrical Tolerance in the MoM Settings object, but a fixed value of 10-5. This may give 
rise to various mesh processing problems that could be solved by changing Relative Geometrical 
Tolerance.  

Device Info is not always up to date 

The frequency information in the Device Info window for a Combined Device was not updated 
after running the CHAMP 3D wizard. 

Combined Device containing only one Device 

The special situation, in which a Combined Device only contains one Device, was not properly 
taken into account and resulted in errors. 

Internal Error could occur when using General Waveguide Device 3D  

If a General Waveguide Device 3D is described by a MoM mesh containing dielectric regions and 
region number 0 is used to denote both the regions inside and outside the waveguide, an internal 
error could occur.  

Cycling reference in Combined Device could result in crash 

In some rare cases a cyclic reference between two Combined Devices was not detected and a 
crash occurred. 
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Default unit not taken into account in plots in CHAMP 3D wizard 

In the CHAMP 3D wizard the default unit was not used on the axes of plots. This was, for instance, 
the case in the plot showing the radius for the mode converter as function of length. 

Mesh warning could occur when analysing a dielectric Waveguide Device 

When analysing a Waveguide Device in which a waveguide port is at a dielectric region with 
permittivity larger than 4, the warning “Mesh contains edges longer than 3 wavelengths” could 
occur.  

MLFMM memory estimate inaccurate for Aperture 3D (requires ESTEAM) 

In the case of analysing an Aperture 3D with MLFMM the reported memory estimate was 
inaccurate. 

Dielectric Support Tube could not be plotted in 2D Device view 

The 2D Device view could not plot a Dielectric Support Tube if its relative permittivity was larger 
than 1. 

 

Bug fixes in the Multibeam Goal Preview (Requires POS) 
Wrong residuals for relative edge-of-coverage  

The multibeam optimisation goal would, under certain circumstances, yield wrong residuals in 
case the goal type was selected as "eoc_rel" (Edge of Coverage, relative). 
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